ASCENT - Center for Technical Knowledge
AutoCAD® Civil 3D® 2018
For Surveyors
Imperial - 1st Edition

Prepared and produced by:
ASCENT Center for Technical Knowledge
630 Peter Jefferson Parkway, Suite 175
Charlottesville, VA 22911
866-527-2368
www.ASCENTed.com

Lead Contributor: Michelle Rasmussen

ASCENT - Center for Technical Knowledge is a division of Rand Worldwide, Inc., providing custom
developed knowledge products and services for leading engineering software applications. ASCENT is
focused on specializing in the creation of education programs that incorporate the best of classroom
learning and technology-based training offerings.

We welcome any comments you may have regarding this learning guide, or any of our products. To contact
us please email: feedback@ASCENTed.com.

© ASCENT - Center for Technical Knowledge, 2017

All rights reserved. No part of this guide may be reproduced in any form by any photographic, electronic,
mechanical or other means or used in any information storage and retrieval system without the written
permission of ASCENT, a division of Rand Worldwide, Inc.

The following are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in
the USA and other countries: 123D, 3ds Max, Alias, AutoCAD LT, AutoCAD, Autodesk, the Autodesk logo, Autodesk
123D, Autodesk Homestyler, Autodesk Inventor, Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSketch,
AutoSnap, AutoTrack, Backburner, Backdraft, Beast, BIM 360, Burn, Buzzsaw, CADD_equal, CAICE, CAMduct, Civil 3D,
Combustion, Communication Specification, Configurator 360, Constructware, Content Explorer, Creative Bridge, Dancing
Baby (image), DesignCenter, DesignKids, DesignStudio, Discreet, DWG, DWG (design/logo), DWG Extreme,
DWG TrueConvert, DWG TrueView, DWGX, DXF, Ecotect, Ember, ESTmep, FABmep, Face Robot, FBX, Fempro, Fire,
Flame, Flare, ForceEffect, FormIt 360, Freewheel, Fusion 360, Glue, Green Building Studio, Heidi, Homestyler,
HumanIK, i-drop, ImageModeler, Incinerator, Inferno, InfraWorks, Instructables, Instructables (stylized robot design/logo),
Inventor, Inventor HSM, Inventor LT, Lustre, Maya, Maya LT, MIMi, Mockup 360, Moldflow Plastics Advisers, Moldflow
Plastics Insight, Moldflow, Moondust, MotionBuilder, Movimento, MPA (design/logo), MPA, MPI (design/logo), MPX
(design/logo), MPX, Mudbox, Navisworks, ObjectARX, ObjectDBX, Opticore, P9, Pier 9, Pixlr, Pixlr-o-matic,
Productstream, Publisher 360, RasterDWG, RealDWG, ReCap, ReCap 360, Remote, Revit LT, Revit, RiverCAD, Robot,
Scaleform, Showcase, Showcase 360, SketchBook, Smoke, Socialcam, Softimage, Spark & Design, Spark Logo, Sparks,
SteeringWheels, Stitcher, Stone, StormNET, TinkerBox, Tinkercad, Tinkerplay, ToolClip, Topobase, Toxik, TrustedDWG,
T-Splines; ViewCube, Visual LiS, Visual, VRED, Wire, Wiretap, WiretapCentral, XSI.

NASTRAN is a registered trademark of the National Aeronautics Space Administration.
All other brand names, product names, or trademarks belong to their respective holders.

General Disclaimer:
Notwithstanding any language to the contrary, nothing contained herein constitutes nor is intended to constitute an offer,
inducement, promise, or contract of any kind. The data contained herein is for informational purposes only and is not
represented to be error free. ASCENT, its agents and employees, expressly disclaim any liability for any damages, losses
or other expenses arising in connection with the use of its materials or in connection with any failure of performance, error,
omission even if ASCENT, or its representatives, are advised of the possibility of such damages, losses or other
expenses. No consequential damages can be sought against ASCENT or Rand Worldwide, Inc. for the use of these
materials by any third parties or for any direct or indirect result of that use.

The information contained herein is intended to be of general interest to you and is provided "as is", and it does not
address the circumstances of any particular individual or entity. Nothing herein constitutes professional advice, nor does
it constitute a comprehensive or complete statement of the issues discussed thereto. ASCENT does not warrant that the
document or information will be error free or will meet any particular criteria of performance or quality. In particular (but
without limitation) information may be rendered inaccurate by changes made to the subject of the materials (i.e. applicable
software), Rand Worldwide, Inc. specifically disclaims any warranty, either expressed or implied, including the warranty
of fitness for a particular purpose.
# Contents

Preface ........................................................................................................... vii

In this Guide ................................................................................................... ix

Practice Files ................................................................................................ xiii

Chapter 1: The AutoCAD Civil 3D Interface ............................................... 1-1

1.1 Product Overview ............................................................................... 1-2

1.2 AutoCAD Civil 3D Workspaces ...................................................... 1-3

Start Tab ........................................................................................... 1-4

1.3 AutoCAD Civil 3D User Interface ................................................... 1-7

Practice 1a Overview of AutoCAD Civil 3D and its User Interface .. 1-12

1.4 AutoCAD Civil 3D Toolspace ....................................................... 1-15

Prospector Tab ................................................................................ 1-16

Settings Tab .................................................................................... 1-18

Survey Tab ...................................................................................... 1-19

Toolbox Tab .................................................................................... 1-19

1.5 AutoCAD Civil 3D Panorama............................................................. 1-21

Practice 1b AutoCAD Civil 3D Toolspace .......................................... 1-23

1.6 AutoCAD Civil 3D Templates, Settings, and Styles ................... 1-30

Drawing Settings in Detail .............................................................. 1-30

Styles .............................................................................................. 1-41

Templates ....................................................................................... 1-48

Practice 1c AutoCAD Civil 3D Styles.................................................. 1-52

Chapter Review Questions ................................................................... 1-58

Command Summary ............................................................................. 1-60

Chapter 2: Connecting to Geospatial Data................................................. 2-1

2.1 Introduction to the Planning and Analysis Workspace ................. 2-2

Map Workflow .................................................................................. 2-2
2.2 Coordinate Systems ................................................................. 2-4
Practice 2a Start a New Project ..................................................... 2-7
2.3 Geospatial Data Connection .................................................... 2-9
   Connect to GIS Data ............................................................... 2-9
   Stylize GIS Data ................................................................. 2-12
   Draw Order ........................................................................... 2-14
Practice 2b Connect to GIS Data .................................................. 2-15
2.4 Create a Surface from GIS Data .............................................. 2-19
   Contour Issues ....................................................................... 2-21
   Minimizing Flat Triangle Strategies ....................................... 2-22
   Draping Images on a Surface ................................................ 2-23
Practice 2c Create a Surface from a Shape File ............................ 2-24
Chapter Review Questions ........................................................... 2-28
Command Summary .................................................................... 2-29

Chapter 3: Survey Setup .............................................................. 3-1
3.1 Survey Workflow Overview .................................................... 3-2
3.2 Collecting Field Data .............................................................. 3-4
3.3 Introduction to the Survey Toolspace ...................................... 3-6
3.4 Survey Figures ....................................................................... 3-7
   Drawing Settings .................................................................... 3-8
   Figure Styles ........................................................................... 3-8
   Figure Prefix Database ........................................................ 3-10
Practice 3a Creating Figure Prefixes ............................................ 3-11
3.5 The Survey Database ............................................................ 3-13
Practice 3b Create a Survey Database ........................................ 3-18
3.6 Lines and Curves ................................................................... 3-21
Practice 3c Input the Project Boundary ....................................... 3-24
3.7 Coordinate Geometry Editor .................................................. 3-27
   Manually Entering COGO Data ............................................. 3-27
Practice 3d Coordinate Geometry Editor .................................... 3-31
Chapter Review Questions ........................................................... 3-35
Command Summary .................................................................... 3-37

Chapter 4: Points ........................................................................ 4-1
4.1 Points Overview ..................................................................... 4-2
   Point Marker Styles .............................................................. 4-4
Practice 4a Point Marker Styles .................................................. 4-8
# Contents

4.2 Point Label Styles ................................................................. 4-13  
  Information Tab .................................................................. 4-14  
  General Tab .................................................................... 4-14  
  Layout Tab .................................................................... 4-15  
  Dragged State Tab ............................................................ 4-17  
  Summary Tab ................................................................ 4-18  

Practice 4b Point Label Styles ................................................... 4-19  

4.3 Point Settings ......................................................................... 4-24  

4.4 Creating Points........................................................................ 4-26  

4.5 Transparent Command ............................................................. 4-27  

Practice 4c Creating AutoCAD Civil 3D Points ......................... 4-28  

4.6 Description Key Sets ................................................................. 4-30  

Practice 4d Creating a Description Key Set ............................... 4-34  

4.7 Importing and Exporting Points ................................................ 4-39  
  To Import Points ................................................................. 4-39  
  Duplicate Point Numbers ..................................................... 4-41  
  Transforming Points on Import or Export ............................. 4-42  

Practice 4e Importing and Exporting Points Part I ...................... 4-44  

Practice 4f Importing and Exporting Points Part II ...................... 4-48  

4.8 Point Groups ......................................................................... 4-50  
  Defining Point Groups ........................................................ 4-50  
  Updating Out of Date Point Groups ...................................... 4-53  
  Overriding Point Group Properties ...................................... 4-53  
  Point Groups Display Properties ......................................... 4-53  

Practice 4g Creating Point Groups .............................................. 4-56  

4.9 Reviewing and Editing Points .................................................. 4-59  
  Repositioning Point Labels .................................................. 4-59  

Practice 4h Manipulating Points .................................................. 4-61  

4.10 Locking/Unlocking Points ...................................................... 4-63  

Practice 4i Point Locking and Editing ......................................... 4-65  

4.11 Point Reports ................................................................. 4-68  
  Point Reports - Reports Manager ......................................... 4-68  
  Point Editor Reports .......................................................... 4-69  

Practice 4j Point Reports ........................................................... 4-70  

Chapter Review Questions ......................................................... 4-71  

Command Summary .................................................................. 4-72
Chapter 5: Points with Connective Codes ................................................. 5-1
5.1 Field Codes................................................................................ 5-2
5.2 Survey Data - Figures ............................................................ 5-6
Practice 5a Importing Data - Figures.................................................... 5-7
5.3 Survey Data - Line Code........................................................... 5-12
Practice 5b Line Code.......................................................................... 5-16
5.4 Translating a Survey Database .................................................... 5-19
Practice 5c Translating Survey Database.......................................... 5-20
Chapter Review Questions.............................................................. 5-23
Command Summary ............................................................................. 5-24
Chapter 6: Field Book Files ......................................................................... 6-1
6.1 Survey Networks ............................................................................. 6-2
6.2 Importing a Field Book ........................................................... 6-4
Practice 6a Importing a Field Book...................................................... 6-7
6.3 Working with Figures...................................................................... 6-10
Practice 6b Field Book Edits, Styles, and Figure Prefixes ............... 6-12
6.4 Filtering a Survey Database.......................................................... 6-17
Practice 6c Filter a Survey Database.................................................. 6-21
Chapter Review Questions................................................................... 6-23
Command Summary ............................................................................. 6-24
Chapter 7: Surfaces...................................................................................... 7-1
7.1 Surface Process .............................................................................. 7-2
7.2 Surface Properties .......................................................................... 7-7
7.3 Surface Data .................................................................................. 7-10
Contours.......................................................................................... 7-10
DEM Files........................................................................................ 7-12
Drawing Objects .............................................................................. 7-12
Point Files ....................................................................................... 7-12
Point Groups ................................................................................... 7-12
Point Survey Queries ...................................................................... 7-13
Figure Survey Queries .................................................................. 7-13
Practice 7a Creating an Existing Ground Surface ............................ 7-14
7.4 Breaklines and Boundaries............................................................ 7-17
Breaklines ....................................................................................... 7-18
Boundaries ...................................................................................... 7-21
Practice 7b Add Additional Data to an Existing Ground Surface .... 7-23
## Contents

7.5 **Surface Editing** ................................................................. 7-31  
Line Edits .................................................................................... 7-32  
Point Edits ................................................................................... 7-32  
Simplify Surface ........................................................................ 7-33  
Smooth Contours ........................................................................ 7-34  
Smooth Surface .......................................................................... 7-35  
Copy Surface ............................................................................. 7-35  
Surface Paste ............................................................................ 7-36  
Raise/Lower Surface ................................................................... 7-36  
Adjusting Surfaces Through Surface Properties .......................... 7-36

7.6 **Surface Analysis Tools** .......................................................... 7-38  
Viewing a Surface in 3D............................................................... 7-38  
Quick Profile ................................................................................ 7-39  

**Practice 7c Surface Edits** ......................................................... 7-40

7.7 **Surface Labels** .................................................................. 7-51  
Contour Labels ........................................................................... 7-52  
Spot and Slope Labels .................................................................. 7-52

7.8 **Surface Volume Calculations** ................................................ 7-53  
Volumes Dashboard ........................................................................ 7-53  
Bounded Volumes ........................................................................ 7-53  
Volume Reports ............................................................................ 7-54  
Grid Volume or TIN Volume Surface ............................................. 7-54  
3D Solid Surface from TIN Surface ............................................. 7-55

7.9 **Surface Analysis Display** ..................................................... 7-57  
Analysis Settings .......................................................................... 7-59  
Analysis Data Display ................................................................... 7-59

**Practice 7d Surface Labeling and Analysis** ................................. 7-60

7.10 **Point Cloud Surface Extraction** ............................................ 7-66  
Attach Point Cloud ....................................................................... 7-66  
Surfaces from Point Clouds .......................................................... 7-71

**Practice 7e Create a Point Cloud Surface** ...................................... 7-75

**Chapter Review Questions** ......................................................... 7-77

**Command Summary** ................................................................ 7-80

**Appendix A: Additional Tools** .................................................... A-1  
A.1 Opening a Survey Database ..................................................... A-2  
A.2 Least Squares ........................................................................ A-3  

**Practice A1 Creating a Least Square Survey** ................................. A-5  
A.3 Creating a Least Squares Input File ........................................... A-8  
Adjustment Analysis ..................................................................... A-9  
Blunder Detection Analysis ............................................................ A-10  
Updating the Survey ..................................................................... A-11
Practice A2 Creating a Least Square Input File and Adjustment ... A-12
A.4 Traverse Basics ................................................................. A-16
   Open Traverse ........................................................................ A-16
   Closed Traverse ..................................................................... A-16
   Closed Connected Traverse .................................................. A-16
   Traverse Data in a Field Book .............................................. A-17

A.5 Defining a Traverse ................................................................. A-18
   Traverse Editor ........................................................................ A-18
   Least Squares Traverse .......................................................... A-19
   Adjustment Reports ................................................................. A-19

Practice A3 Creating a Network Traverse ........................................ A-20
A.6 Multiple Network Surveys ..................................................... A-26
   Survey Points .......................................................................... A-26
   Closed Connected Traverse .................................................. A-27
   Field Book Edits ..................................................................... A-27

Practice A4 Closed Connect Traverse ............................................ A-29

Appendix B: AutoCAD Civil 3D Certification Exam Objectives .......... B-1

Index ............................................................................................. Index-1
Preface

This in-depth *AutoCAD® Civil 3D® 2018 for Surveyors* learning guide is for surveyors and survey technicians that do not necessarily need all of the functionality that is taught in *AutoCAD Civil 3D Fundamentals*. This learning guide equips the surveyor with the basic knowledge required to use *AutoCAD Civil 3D* efficiently in a typical daily workflow. Students learn how to import the converted field equipment survey data into a standardized environment in *AutoCAD Civil 3D* and to use the automation tools to create an Existing Condition Plan. Data collection, and traverses are also covered. Other topics that help in increasing efficiency include styles, correct *AutoCAD®* drafting techniques, the methodology required to create linework effectively for variables used in defining symbology, surfaces, categorizing points, and importing imagery.

**Topics Covered**

- The *AutoCAD Civil 3D* Interface
- The Planning and Analysis workspace
- Points overview and styles
- Importing points and coordinate transformations
- Creating points and drafting
- Point groups, grips, and reports
- Point security and editing
- Introduction to data collection in the field
- Introduction to *Civil 3D Survey* and automated linework
- Survey networks
- Coordinate Geometry Editor for entering traverse information or legal descriptions
- Surface overview
- Surface editing
- Surface labels and analysis
- Point clouds and creating a surface from point cloud data
Note on Software Setup

This learning guide assumes a standard installation of the software using the default preferences during installation. Lectures and practices use the standard software templates and default options for the Content Libraries.

Students and Educators can Access Free Autodesk Software and Resources

Autodesk challenges you to get started with free educational licenses for professional software and creativity apps used by millions of architects, engineers, designers, and hobbyists today. Bring Autodesk software into your classroom, studio, or workshop to learn, teach, and explore real-world design challenges the way professionals do.

Get started today - register at the Autodesk Education Community and download one of the many Autodesk software applications available.

Visit www.autodesk.com/joinedu/

Note: Free products are subject to the terms and conditions of the end-user license and services agreement that accompanies the software. The software is for personal use for education purposes and is not intended for classroom or lab use.

Lead Contributor: Michelle Rasmussen

Specializing in the civil engineering industry, Michelle authors training guides and provides instruction, support, and implementation on all Autodesk infrastructure solutions, in addition to general AutoCAD.

Michelle began her career in the Air Force working in the Civil Engineering unit as a surveyor, designer, and construction manager. She has also worked for municipalities and consulting engineering firms as an engineering/GIS technician. Michelle holds a Bachelor’s of Science degree from the University of Utah along with a Master’s of Business Administration from Kaplan University. Michelle is an Autodesk Certified Instructor (ACI) as well as an Autodesk Certified Evaluator, teaching and evaluating other Autodesk Instructors for the ACI program. In addition, she holds the Autodesk Certified Professional certification for Civil 3D and is trained in Instructional Design.

As a skilled communicator, Michelle effectively leads classes, webcasts and consults with clients to achieve their business objectives.

Michelle Rasmussen has been the Lead Contributor for AutoCAD Civil 3D for Surveyors since 2011.
In this Guide

The following images highlight some of the features that can be found in this Learning Guide.

FTP link for practice files

Practice Files

The Practice Files page tells you how to download and install the practice files that are provided with this learning guide.

Chapter 1

Getting Started

In this chapter you learn how to start the AutoCAD® software, become familiar with the basic layout of the AutoCAD screen, how to access commands, use your pointing device, and understand the AutoCAD Command workspace. You also learn how to open an existing drawing, view a drawing by zooming and panning, and save your work in the AutoCAD software.

Learning Objectives for this Chapter

- Launch the AutoCAD software and complete a basic initial setup of the drawing environment.
- Identify the basic layout and features of AutoCAD workspace including the Ribbon, Drawing Window, and Application Bar.
- Locate commands, and launch them using the Ribbon, shortcut menu, Application Bar, and keyboard.
- Locate points in the AutoCAD Command workspace.
- Open and close existing drawings and navigate to the locations.
- Move around a drawing using the Zoom and Pan commands, and the Navigation bar.
- Save drawings in various formats and set the automatic save options using the Save Options Bar.

Chapters

Each chapter begins with a brief introduction and a list of the chapter’s Learning Objectives.
Section 1.3 Working with Commands

Starting Commands

The main way to access commands in the AutoCAD software is to use the Ribbon. Several of the key commands are available in the Ribbon. Other commands are available in the Status Bar, Quick Access toolbar, and through the Quick Access menu. For quick access, you can right-click on an object to access context menus. The names of all the commands can be typed in the Command Line. A table is included to help you identify the various methods of accessing the commands. When typing the name of a command in either the Command Line or Quick Access toolbar, the AutoComplete option automatically completes the entry as you type as you type. It also supports multiview search by displaying all of the commands that contain the word(s) you typed, as shown in Figure 1-12. You can then scroll through the list and select a command.

You can also click the Command to display the list of AutoComplete options.

If you need to stop a command, press Ctrl+C to cancel. You might need to press Ctrl+C more than once.

Figure 1-12

To set specific options for the AutoComplete feature, right-click on the Command Line, expand Input Settings, and select from the available options, such as the ability to search for system variables or to set the delay response time, as shown in Figure 1-13.

Figure 1-13

As you work in the AutoCAD software, the software prompts you for the information that is required to complete specific tasks. These prompts are displayed in the drawing window near the cursor and in the Command Line. It is typical that you type the command prompts as you work, as shown in Figure 1-14.

Figure 1-14

Practice Objectives

Practice Objectives

Estimated time for completion: under 5 minutes.

In this practice you will open a drawing, save it, and modify the Automatic Save setting, as shown in Figure 1-15.

Figure 1-15

1. Open Building Valley Road drawing from your class files folder.
2. In the Quick Access Toolbar, click Save. In the Command Line, QSAVE displays indicating that the AutoCAD software has performed a quick save.
3. In the Application Menu, click Open to open the Options dialog box.
4. In the Open and Save tab, change the time for Automatic Save to 15 minutes.

Chapter Review Questions

Chapter Review Questions

1. How do you switch from the drawing window to the text window?
   a. Use the icons in the Status Bar.
   b. Press <Tab>.
   c. Press <F2>.
   d. Press the <spacebar>.
2. How can you cancel a command using the keyboard?
   a. Press <Esc>.
   b. Press <Esc>.
   c. Press <Ctrl+H>.
   d. Press <Delete>.
3. What is the quickest way to repeat a command?
   a. Press <Tab>.
   b. Press <Esc>.
   c. Press <Enter>.
   d. Press <Enter>.
4. To display a specific Ribbon panel, you can right-click on the Ribbon and select the required panel in the contextual menu.
   a. True
   b. False
5. How are points specified in the AutoCAD Cartesian workspace?
   a. X value Y value

Instructional Content

Each chapter is split into a series of sections of instructional content on specific topics. These lectures include the descriptions, step-by-step procedures, figures, hints, and information you need to achieve the chapter’s Learning Objectives.

Practices

Practices enable you to use the software to perform a hands-on review of a topic.

Some practices require you to use prepared practice files, which can be downloaded from the link found on the Practice Files page.

Chapter Review Questions

Chapter review questions, located at the end of each chapter, enable you to review the key concepts and learning objectives of the chapter.
## Command Summary

The Command Summary is located at the end of each chapter. It contains a list of the software commands that are used throughout the chapter, and provides information on where the command is found in the software.

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Civil</td>
<td>Opening Workspace</td>
<td>Application Menu</td>
</tr>
<tr>
<td>Civil Drafting</td>
<td>Application Menu</td>
<td>Command Prompt: menu</td>
</tr>
<tr>
<td>Civil 3D</td>
<td>Application Menu</td>
<td></td>
</tr>
<tr>
<td>MA Dynamic Input</td>
<td>Status Bar: Help</td>
<td>Application Menu</td>
</tr>
<tr>
<td>BiA AutoCAD</td>
<td>Application Menu</td>
<td></td>
</tr>
</tbody>
</table>

### Autodesk Certification Exam Appendix

This appendix includes a list of the topics and objectives for the Autodesk Certification exams, and the chapter and section in which the relevant content can be found.

### Icons in this Learning Guide

The following icons are used to help you quickly and easily find helpful information.

- **New in 2018**
  - Indicates items that are new in the Civil 3D 2018 software.

- **Enhanced in 2018**
  - Indicates items that have been enhanced in the Civil 3D 2018 software.
The AutoCAD Civil 3D Interface

In this chapter you learn about the AutoCAD® Civil 3D® software interface and terminology. You learn how to navigate the available workspaces, the Toolspace, and how to work in a dynamic model environment. You also learn how to use styles across multiple models, to ensure that your drawings adhere to specific standards.

Learning Objectives in this Chapter

• Switch between the AutoCAD Civil 3D tools, 2D drafting and annotation tools, 3D modeling tools, and planning and analysis tools by changing the workspace.
• Locate the basic features and commands of the AutoCAD Civil 3D software interface which include the Ribbon, Drawing Window, Command Line, Toolspace, etc.
• Access commands by right-clicking on an object or collection of objects in the Prospector and Settings tabs in the Toolspace.
• Access predefined reports and create custom reports to be able to share useful engineering data about AEC objects in a drawing.
• Create and assign object and label styles to correctly display AutoCAD Civil 3D objects for printing and other purposes.
1.1 Product Overview

The AutoCAD Civil 3D software supports a wide range of Survey and Civil Engineering tasks. It creates intelligent relationships between objects so that design changes can be updated dynamically.

- The AutoCAD Civil 3D software uses dynamic objects for points, alignments, profiles, terrain models, pipe networks, etc. Objects can update when data changes. For example, if an alignment changes, its associated profiles and sections update automatically. Commands can be safely undone in the software without the graphics becoming out-of-date with survey and design data.

- These objects are style-based and dynamic, which streamlines object creation and editing.

- AutoCAD Civil 3D objects (surfaces, alignments, etc.) are often stored directly inside drawing files. The only time they are not is when working with the Autodesk Data Management System (Vault), data shortcuts, or a survey database.

- The AutoCAD Civil 3D software, unlike the AutoCAD® Land Desktop software, supports a multiple document interface. This means that more than one drawing file can be open in the same session of the AutoCAD Civil 3D software at the same time. Users of AutoCAD Land Desktop software who are going to use the AutoCAD Civil 3D software, should be aware that, by default, opening a second drawing does not automatically close any currently open drawings.

- The AutoCAD Civil 3D software can be launched by selecting its icon on the desktop or by accessing the command through the Start menu. Depending on the installed version of the software, the icon indicates Imperial or Metric. Once launched, the software initiates with the standard AutoCAD Civil 3D profile. You can also customize the shortcut to have the software launch with a project based setting. This is accomplished using a custom profile.
1.2 AutoCAD Civil 3D Workspaces

When the AutoCAD Civil 3D software is launched for the first time, a Let’s Get Started window displays, as shown in Figure 1–1. This window is used to verify your AutoCAD Civil 3D license. There are three options for communicating your license information:

- **Sign In**: Use your Autodesk Subscription account information to verify your purchase.
- **Enter a Serial Number**: Manually type in your software serial number and software key.
- **Use a Network License**: Point the software to your network license server to find the software license.

![Figure 1–1](image.png)
Start Tab

By default, the Start tab is continually available even when a drawing file is open. It enables you to complete several actions, as shown in Figure 1–2:

- Create new drawings from template files (1)
- Open existing files (2)
- Open a sheet set (3)
- Download online templates (4)
- Open example drawings (5)
- Review and open recent documents (6)
- Review notifications from Autodesk (7)
- Sign in to the Autodesk 360 service (8)
- Send feedback to Autodesk about the AutoCAD Civil 3D software (9)

The Start tab is persistent even when other drawings are open. This makes it easier and faster to open or start new drawings.

Figure 1–2
It is recommended that you stay in the Civil 3D workspace most of the time. As a review, AutoCAD® Workspaces are saved groupings of menus, toolbars, and palettes, which can be customized as required for specific tasks. You can modify the default Workspaces supplied with the AutoCAD Civil 3D software or create your own. In this material, you work with the Civil 3D workspace, which includes a complete list of AutoCAD Civil 3D-specificRibbons, drop-down menus, and tools.

Workspaces can be changed using the Workspaces switching icon in the lower right corner of the Status Bar, as shown in Figure 1–3. They can also be modified using the CUI command.
Each of the ribbons from the workspaces are shown in order in Figure 1–4 and include the following:

- **Civil 3D workspace**: Contains tools used to create AEC objects, such as surfaces, alignments, profiles, corridors, grading objects, etc.
- **Drafting & Annotation workspace**: Contains tools that are commonly used in the standard AutoCAD software, such as those in the Home tab>Draw and Modify panels.
- **3D Modeling workspace**: Contains standard AutoCAD 3D modeling tools for designing 3D solids, mesh surfaces, etc.
- **Planning and Analysis workspace**: Contains tools found in the AutoCAD® Map 3D® software that help you to attach and analyze GIS data for more efficient planning of projects before starting your design.
1.3 AutoCAD Civil 3D User Interface

The AutoCAD Civil 3D software user interface is shown in Figure 1–5.

![Figure 1–5](image)

- **1. Application Menu**
- **2. Quick Access Toolbar**
- **3. InfoCenter**
- **4. Ribbon**
- **5. Tooltips**
- **6. Drawing Window**
- **7. Command Line**
- **8. Status Bar**
1. Application Menu

The Application Menu provides access to commands, settings, and documents, as shown in Figure 1–6. With the Application Menu you can:

- Browse the menus available in the AutoCAD Civil 3D software.
- Perform a search of menus, menu actions, tooltips, and command prompt text strings.
- Browse for recent documents, currently open documents, and commands you have recently executed.

![Figure 1–6](image)

2. Quick Access Toolbar

The Quick Access Toolbar provides access to commonly used commands, such as Open, Save, Print, etc. You can add an unlimited number of tools to the Quick Access Toolbar by clicking the down arrow on the right, as shown in Figure 1–7.

![Figure 1–7](image)
3. InfoCenter

The *InfoCenter* enables you to quickly search for help. You can specify which Help documents to search, and collapse or expand the search field (as shown in Figure 1–8) to save screen space. You can also sign in to the A360 service, where you can share files with other design team members using the cloud.

provides the ability to connect to the Autodesk App Store to find additional efficiency enhancing applications.

![Figure 1–8](image)

4. Ribbon

The *ribbon* provides a single, compact location for *commands* that are relevant to the current task. It contains tools in a series of *tabs* and *panels* to reduce clutter in the application and maximize drawing space. Selecting a tab displays a series of panels. The panels contain a variety of tools, which are grouped by function, as shown in Figure 1–9.

![Figure 1–9](image)
Clicking the drop-down arrow expands the panel to display additional tools, as shown in Figure 1–10. Clicking an arrow pointing to the bottom right opens the tool’s dialog box, which contains additional options.

Figure 1–10

You can minimize the ribbon by clicking the arrow successively, as shown in Figure 1–11.

Figure 1–11

There are two classifications of Ribbons: static and contextual.

- **Static Ribbons**: Display the most commonly used tabs, panels, and commands.

- **Contextual Ribbons**: Display the tabs, panels, and commands that are only applicable to the selected object. An example of a contextual ribbon is shown in Figure 1–12.
5. Tooltips

Tooltips display the item's name, a short description, and sometimes a graphic. They provide information about tools, commands, and drawing objects, as shown in Figure 1–13.

Figure 1–13

6. Drawing Window

The **Drawing Window** is the area of the screen where the drawing displays.

7. Command Line

The **Command Line** is a text window that is located at the bottom of the screen and displays command prompts and a history of commands, as shown in Figure 1–14.

Figure 1–14

8. Status Bar

The **Status Bar** enables you to change many of AutoCAD's drafting settings, such as Snap, Grid, and Object Snap, as shown in Figure 1–15.

Figure 1–15
Practice 1a: Overview of AutoCAD Civil 3D and its User Interface

Practice Objective

- Locate the basic features and commands of the AutoCAD Civil 3D software interface which includes the Ribbon, Toolspace, Drawing Window, Command Line, etc.

In this practice you will become familiar with AutoCAD Civil 3D’s capabilities and learn about its interface.

Task 1 - Set up the practice.

In this task, you will add a folder shortcut in the pane on the left side of the dialog box. This enables you to quickly access the practice files folder in the Open dialog box.

1. If required, start the AutoCAD Civil 3D 2018 Imperial application.

2. In the Start tab, click  (Open), or expand (Application Menu) and select Open. In the Select File dialog box, browse to the C:\Civil 3D for Surveyors Practice Files folder.

3. Expand the Tools drop-down list and select Add Current Folder to Places, as shown in Figure 1–16.

4. Double-click on the Interface folder to display its contents. Select INTRO-Introduction.dwg and then select Open.

Figure 1–16
If prompted to save the changes to your Places List, click Yes.

By default, the Toolspace is docked to the left side of your drawing window.

5. In the Status Bar, confirm that Civil 3D is the active Workspace. The Workspace icon is located in the Status Bar (at the bottom right of the interface) and in the Quick Access Toolbar (at the top left of the interface), as shown in Figure 1–17.

![Figure 1–17](image)

6. Select the Home tab and ensure that the Layers panel displays. If it is not, right-click anywhere on the ribbon and select Layers, as shown in Figure 1–18.

![Figure 1–18](image)

7. Locate the AutoCAD Civil 3D Toolspace (as shown in Figure 1–19). If you cannot find it, click (Toolspace) in the Home tab>Palettes panel.

![Figure 1–19](image)

8. Save the drawing as Example 1.dwg. To do this, expand (Application Menu) and select Save As. In the File Name field, type Example 1 and click Save.
Task 2 - Review AutoCAD Civil 3D’s Dynamic Object Model.

1. In the top-left corner of the drawing window, select Top, expand Custom Model Views and select Aln-Profile, as shown in Figure 1–20. This will zoom into a preset view of the alignment and the surface profile to the right.

![Figure 1–20](image)

2. Select the Jeffries Ranch Rd alignment to activate its grips, as shown in Figure 1–21. (If you have difficulty selecting the alignment, you might need to set the draw order so that it is on top of all of the other objects.) Select the eastern grip and reposition it. The alignment and profile both update.

![Figure 1–21](image)

3. Hover the cursor near the alignment in its new position. The station, offset, and surface elevation information display through tooltips.

4. Close the drawing without saving.
1.4 AutoCAD Civil 3D Toolspace

The AutoCAD Civil 3D software uses a Toolspace to manage objects, settings, and styles. Each tab uses a hierarchical tree interface to manage objects, settings, and styles. Branches in these hierarchical trees are referred to in the AutoCAD Civil 3D software as collections. The Toolspace is an interactive data management tool.

Toolspace operates similar to an AutoCAD tool palette in that it can be resized, set to dock or float, and when floating can be set to auto-hide. The Toolspace is shown floating on the left in Figure 1–22 and docked on the right in Figure 1–22.

Right-clicking on a collection or on an individual object provides many commonly used commands in the shortcut menus.

- The Toolspace can be closed by selecting the X in the upper left or right corner.

- Once closed, it can be opened by clicking (Toolspace) in the Home tab>Palettes panel.
Prospector Tab

The Toolspace, Prospector tab, lists the AutoCAD Civil 3D objects that are present in open drawings and other important information. Its hierarchical structure dynamically manages and displays objects and their data. As objects are created or deleted, they are removed from the Prospector tab. A drop-down list at the top contains the following options:

- **Active Drawing View**: Displays only the AutoCAD Civil 3D objects that are present in the active drawing. If you switch to another drawing, the tree updates to reflect the currently active drawing.

- **Master View**: Displays a list of all open drawings and their objects, project information, and a list of drawing templates. The name of the active drawing is highlighted.

The Toolspace, Prospector tab is shown in Figure 1–23.

**Figure 1–23**

- To toggle the display of the Toolspace, Prospector tab on or off, click

  ![Prospector](image)

  (Prospector) in the Home tab>Palettes panel.

- Each object type (Points, Point Groups, Alignments, Surfaces, etc.) is allotted a collection, and objects present in a drawing are listed below the respective collection.
• The bottom of the Toolspace, Prospector tab displays a list view of items in the highlighted collection or a preview of an object that has been selected in the Toolspace, Prospector tab.

• The icon at the top of the Toolspace, Prospector tab controls how items in the Prospector tree display. Icons next to objects provide additional information about the object. A list of common icons is as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Toggles" /></td>
<td>Toggles the Toolspace item preview on or off.</td>
</tr>
<tr>
<td><img src="image" alt="Panorama" /></td>
<td>Opens (or closes) the Panorama window. This window only opens if vistas are available to be displayed in the Panorama.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Opens the AutoCAD Civil 3D Help system.</td>
</tr>
<tr>
<td><img src="image" alt="Locked" /></td>
<td>Indicates that the object is currently locked for editing.</td>
</tr>
<tr>
<td><img src="image" alt="Referenced" /></td>
<td>Indicates that the object is referenced by another object. In the Toolspace, Settings tab, this also indicates that a style is in use in the current drawing.</td>
</tr>
<tr>
<td><img src="image" alt="Referenced From" /></td>
<td>Indicates that the object is being referenced from another drawing file (such as through a shortcut or Vault reference).</td>
</tr>
<tr>
<td><img src="image" alt="Out Of Date" /></td>
<td>Indicates that the object is out of date and needs to be rebuilt, or is violating specified design constraints.</td>
</tr>
<tr>
<td><img src="image" alt="Vault Modified" /></td>
<td>Indicates that a vault project object (such as a point or surface) has been modified since it was included in the current drawing.</td>
</tr>
<tr>
<td><img src="image" alt="Modified In Current Drawing" /></td>
<td>Indicates that you have modified a vault project object in your current drawing and that those modifications have yet to be updated to the project.</td>
</tr>
</tbody>
</table>
**Settings Tab**

The Toolspace, **Settings** tab is used to configure how the AutoCAD Civil 3D software operates and the way AutoCAD Civil 3D objects are displayed and printed, as shown in Figure 1–24.

![Figure 1–24](image)

Different settings are accessed by right-clicking on the name of a drawing file or on one of the collections located inside the tab.

The collections (such as the *Parcel* collection shown in Figure 1–24) can contain object styles, label styles, command settings, and related controls.

Changes to settings affect all lower items in the tree. For example, assigning an overall text height in the drawing’s Edit Label Style Defaults dialog box applies that height to all other settings and styles in the drawing. Applying the same setting in the *Surface* collection’s Edit Label Style Defaults only applies the text height to the surface label styles. (Lower items in the tree and styles can be set to override these changes individually as required.)

- All drawing settings originate from the template used to create an AutoCAD Civil 3D drawing.
- To toggle the display of the Toolspace, **Settings** tab on or off, click **Settings** (Settings) in the **Home** tab>**Palettes** panel.
Survey Tab

The Toolspace, Survey tab is used to manage survey observations data, as shown in Figure 1–25.Selecting this tab enables you to create a survey database, a survey network, points, and figures, and import and edit survey observation data.

To toggle the Toolspace, Survey tab display on or off, click (Survey) in the Home tab>Palettes panel.

Toolbox Tab

The Toolspace, Toolbox tab can be toggled on and off by clicking (Toolbox) in the Home tab>Palettes panel.

The Toolspace, Toolbox tab is used to access the Reports Manager and to add custom tools to the AutoCAD Civil 3D interface, as shown in Figure 1–26.
The Reports Manager, the only set of tools that displays in the toolbox by default, enables you to generate a large variety of survey and design reports. For example, to launch a Stakeout Alignment Report, right-click on it in the Alignments collection and select **Execute**.

The icons in the upper left area of the Toolspace, **Toolbox** tab enable you to:

- Open the Edit Report Settings dialog box, in which you can assign settings for all report types. These settings include items, such as the name to display in the report.

- Open the Toolbox Editor, in which you can add custom reports and other tools.

Once a report has been executed, it can be saved in multiple formats, including .HTML, .DOC, .XLS, .TXT, and .PDF. To save it in a format other than the default .HTML, expand Files of type and select the type of file required, as shown in Figure 1–27.
1.5 AutoCAD Civil 3D Panorama

The AutoCAD Civil 3D software includes a multi-purpose grid data viewer called the Panorama window. It is similar to an AutoCAD tool palette in that it can be docked or floating, and set to auto-hide. Each tab in the Panorama is called a Vista. The Panorama can be opened from the AutoCAD Civil 3D Toolspace by clicking (Panorama), and can be closed by selecting the X in the upper left or right corner of the window. You can only display the Panorama after launching a command that uses it, such as Edit Points (right-click on a Point Group in the Toolspace, Prospector tab in the Toolspace to access this option). The Panorama can display many different kinds of data, such as point properties, alignment, and profile data, as shown in Figure 1–28.

![Figure 1–28](image)

The Panorama can also display a special Vista called the Event Viewer, as shown in Figure 1–29. The Event Viewer opens prompting you about the status of the performed action. If every thing was successful, it displays a white circle containing a blue i, indicating that it is for informational purposes only. When there are items of interest or an item needs attention, a yellow triangle containing a black ! (exclamation point) displays.
When the AutoCAD Civil 3D software encounters a processing error, such as when surface breaklines cross or a road model passes over the edge of the existing ground surface, a red circle containing a white x displays. When working through a large number of events, you can use Action>Clear All Events to clear all of the old entries in the Panorama.

If a Panorama contains multiple Vistas, selecting a green checkmark only closes the current Vista. To close (hide) the Panorama, select the X in the top right or left corner.

Figure 1–29
**Practice 1b**

Estimated time for completion: 10 minutes

If the Toolspace is not displayed, click (Toolspace) in the Home tab>Palettes panel.

---

**AutoCAD Civil 3D Toolspace**

**Practice Objective**

- Access commands and change the drawing using the AutoCAD Civil 3D Toolspace.

In this practice you will explore the tabs in the AutoCAD Civil 3D Toolspace.

**Task 1 - Review the Toolspace, Prospector tab.**

1. Open INTRO-Introduction.dwg from the C:\Civil 3D for Surveyors Practice Files\Interface folder.

2. Ensure that the AutoCAD Civil 3D Toolspace displays.

3. Select the Toolspace, Prospector tab to make it active. (The tabs are listed vertically along the right side of the Toolspace.)

4. Select the + signs to open the collections and the - signs to close them. Items displayed in the Toolspace, Prospector tab are the design data (also known as AEC objects) currently in the drawing file (such as points, alignments, and surfaces).

5. Collections, such as Points, do not have a + or - sign because they are not intended to be expanded in the tree view of the Toolspace, Prospector tab. Select the Points collection and the list view displays in the Preview area, describing the AutoCAD Civil 3D points that are currently in the drawing file.

6. Under the Surface collection, look for the surface called ExTopo. Expand its branch and the Definition area inside it. Highlight the items below (breaklines, boundaries, etc.) and note the components displayed in the list view.

7. With Existing Ground’s breaklines highlighted in the list view, right-click on Ridge and note the commands available in the shortcut menu, as shown on the left in Figure 1–30. Select Zoom to.
Similar shortcut menus are available for nearly all of the objects displayed in the Toolspace, Prospector tab.

8. Expand the Point Groups and select the **Boundary Pin Survey** point group. In the Preview area at the bottom, press <Shift> to select both point numbers 2 and 3, as shown on the right in Figure 1–30. Right-click and select **Zoom To**. Although the points are not displayed, the software knows where they reside in the drawing.

![Figure 1–30](image_url)

**Figure 1–30**

**Task 2 - Review the Toolspace, Settings tab.**

1. Select the Toolspace, Settings tab, as shown in Figure 1–31.

![Figure 1–31](image_url)

**Figure 1–31**
2. In the Toolspace, **Settings** tab, right-click on the drawing’s name (**INTRO-Introduction.dwg**, at the top), and select **Edit Drawing Settings**.

3. In the Drawing Settings dialog box, select the **Units and Zone** tab, as shown in Figure 1–32.

![Figure 1–32](image)

4. Expand the Scale drop-down list in the upper right corner and select **1”=40’**.

5. Note the coordinate systems that are available in the **Zone** area, such as CA83-VIF, NAD83 California State Planes, Zone VI, and US Foot.

6. Click **OK** to close the dialog box.
Because AutoCAD Civil 3D labels are annotative, the label annotation size has changed to match the new Drawing Scale.

7. You can also change the Model Space display scale using the **Annotation** icon in the Status Bar. Change it to read 1"=80'. Note that as you change the scale, all of the labels also change in size, as shown in Figure 1–33.

![Figure 1–33](image)

8. You can change the display of the contours by changing the style of the surface. In the drawing, select the surface object so that the contextual tab displays in the ribbon, as shown in Figure 1–34.

![Figure 1–34](image)

Alternatively, you can right-click and select **Surface Properties**

9. In the Modify panel, click **(Surface Properties)**.
10. In the *Information* tab, select the drop-down arrow for the surface style, as shown in Figure 1–35. Select any of the predefined styles and click **Apply** to apply the selected style to the surface to preview the results before they display in the dialog box.

![Figure 1–35](image)

11. Click **OK** to exit the Surface Properties dialog box.

12. Save the drawing.

**Task 3 - Review AutoCAD Civil 3D’s Reports Manager.**

1. In the Toolspace, *Toolbox* tab, expand Reports Manager>Alignment, then right-click on **PI Station Report**, and select **Execute**, as shown in Figure 1–36.

![Figure 1–36](image)

As a shortcut, you can double-click to launch the **Report** without having to select the **Execute** command.
2. Accept all of the defaults and click **Create Report**. The report displays, as shown in Figure 1–37.

![Alignment PI Station Report](image)

**Figure 1–37**

3. Review the report and close the Internet Browser.

4. In the Create Reports dialog box, click **Done**.

5. In the Toolspace, **Toolbox** tab, expand the **Surface** collection. Select **Surface Report**, right-click, and select **Execute**, as shown in Figure 1–38.

![Surface Report](image)

**Figure 1–38**
6. Accept all of the defaults and click **OK**. Type a filename for the saved report or accept the default. Expand the Files of type drop-down list, select .XLS and select **Save**. The report displays in Microsoft Excel, as shown in Figure 1–39. Review and close the report.

![Figure 1–39](image-url)
1.6 AutoCAD Civil 3D Templates, Settings, and Styles

A drawing template (.DWT extension) contains all blocks, Paper Space title sheets, settings, and layers for a new drawing. As with the AutoCAD software, a template (.DWT) file in the AutoCAD Civil 3D software is the source file from which new drawings acquire their settings, units, layers, blocks, text styles, etc., and therefore, enforces standardization. With the AutoCAD Civil 3D software, in addition to the AutoCAD components noted, the drawing template is also the source for specific AutoCAD Civil 3D styles and settings. As you learn, AutoCAD Civil 3D styles and settings (Feature and Command) have a profound impact on the appearance of objects, labels, and tables. These styles and settings also act as the primary mechanism that controls the behavior and default actions. Selecting the correct template for your intended design and standards needs is a significant component of fully using the benefits that the AutoCAD Civil 3D software offers. Therefore, it is highly recommended that all styles and setting be set up in the template file before you use the AutoCAD Civil 3D software in a project.

To use the AutoCAD Civil 3D software efficiently and effectively, you need to configure styles and settings to control the object display. All of these styles and settings affect the final delivered product and enable you to deliver a product with consistent quality.

To create a template file, use the Save As command and in the Save As dialog box, change the File of Type to DWT.

The values in Drawing Settings influence every aspect of the drafting drawing environment. Each tab has values affecting a specific drawing area. For example, layer naming properties, coordinate systems, default precisions, input and output conventions, abbreviations for alignment, volume units, etc. After implementing the AutoCAD Civil 3D software, you only need to access the first two tabs.

To access Drawing Settings, in the Toolspace, Settings tab, select and right-click on the drawing name (at the top), and select Edit Drawing Settings.
Units and Zone

In the Drawing Settings dialog box, the Units and Zone tab (as shown in Figure 1–40), sets the Model Space plotting scale and coordinate zone for the drawing. The scale can be a custom value or selected from a drop-down list. A zone is selected from a drop-down list of worldwide categories and coordinate systems.

A drawing which has been assigned a coordinate system enables points to report their grid coordinates and/or their longitude and latitude. Conversely, when assigning a coordinate system, grid coordinates and Longitude and Latitude data can create points in a drawing.

![Figure 1–40](image)

When plotting from the Model tab, the drawing scale in the upper right corner is the scale at which you would prefer the drawing to be printed. When in the Model tab, changing this scale automatically updates all AutoCAD Civil 3D annotations that are scale-dependent. (AutoCAD Civil 3D annotations are automatically resized for correct plotting in each viewport that displays them based on that viewport's scale.)
Changing the drawing scale does not automatically change the `ltscale` variable, since it assumes that you most often prefer to leave it at `ltscale = 1`. If this is not the case, you need to assign this variable manually. Refer to the AutoCAD User Guide if you need more information on variables, such as `ltscale`.

You can also set the drawing scale by assigning a different annotation scale in the Status Bar, as shown in Figure 1–41. In layouts you can change either the VP Scale or Annotation Scale and have both update.

![Figure 1–41](image1)

**Transformation**

During the life of a project, there can be reasons to change local point coordinates to a coordinate system. The values in the *Transformation* tab (as shown in Figure 1–42), transform local coordinates to a State Plane Coordinate system, UTM system, or other defined planar system.

![Figure 1–42](image2)
Object Layers

The *Object Layers* tab (shown in Figure 1–43), assigns layer names to AutoCAD Civil 3D objects. A modifier, which can be a prefix or a suffix, is associated with each layer's name. The value of the modifier can be anything that is typed into its *Value* field. Traditionally, the value is an * (asterisk) with a separator (a dash or underscore). The AutoCAD Civil 3D software replaces the asterisk with the name of the object of the same type. For example, the base surface layer name is **C-TOPO** with a suffix modifier of -* (a dash followed by an asterisk). When a surface named **Existing** is created, it is placed on the layer **C-TOPO-EXISTING**, and when a surface named **Base** is created it is placed on the layer **C-TOPO-BASE**.

The last column of the *Object Layers* tab enables you to lock the values. When a value is locked at this level, the AutoCAD Civil 3D software does not permit it to be changed by any lower style or setting.

![Object Layers Tab](image)

*Figure 1–43*
To change the listed object layers, double-click on a layer name. In the Layer Selection dialog box (shown in Figure 1–44), select the layer from the list. If the layer does not exist, click **New** in the Layer Selection dialog box. This opens a second dialog box, in which you can define a new layer for the object type.

**Figure 1–44**

**Abbreviations**

The Abbreviations tab (shown in Figure 1–45), sets standard values for reports referencing alignment or profile data. Some entries in this panel have text format strings that define how the values associated with the abbreviation display in a label.

**Figure 1–45**
Ambient Settings

In the Ambient Settings tab (shown in Figure 1–46), the values influence prompting and reports. For example, the Direction area affects the prompting for direction input: Decimal Degrees, Degrees Minutes and Seconds (with or without spaces), or Decimal Degrees Minutes and Seconds. Any value set at this level affects everything (labels and commands) in the drawing.

Figure 1–46
Edit Label Style Defaults

The values assigned in the Edit Label Style Defaults dialog box (shown in Figure 1–47), control text style, plan orientation, and the basic behavior of label styles. Similar to Feature Settings, this dialog box is available at the drawing level and at the individual objects level. Editing Label Style defaults at the drawing level affects all label styles in the drawing. Editing them at the object level (such as surfaces) only affects that object’s labels.

![Edit Label Style Defaults Dialog Box](image)

Figure 1–47

In the Label, Behavior, and Plan Readability areas, the values affect the overall visibility of labels, their default text style, label orientation, and the rotation angle that affects plan readability.

The values in the Components, Leader, and Dragged State Components areas affect the default text height for the label, colors for the text, leader, surrounding box, and type of leader. There are also several settings defining what happens to a label when you drag it from its original position.
Edit Autodesk LandXML Settings

The LandXML Settings dialog box (shown in Figure 1–48), provides settings that control how Autodesk LandXML data is imported and exported from the AutoCAD Civil 3D software. Autodesk LandXML is a universal format for storing Surveying and Civil Engineering data that enables you to transfer points, terrain models, alignments, etc., between different software platforms. For more information, see www.landxml.org and the AutoCAD Civil 3D Help system. The dialog box can be opened by right-clicking on Drawing Name in the Toolspace, Settings tab and selecting Edit LandXMLSettings.

![Figure 1–48](image)

All copying and reuse strictly forbidden.
Feature Settings

In the Toolspace, Settings tab, each object type collection has an Edit Feature Settings dialog box, as shown for Surface in Figure 1–49. Its main function is to assign default naming values, initial Object and Label styles, and overriding the default values found in Edit Drawing Settings for that object type. You can access the feature settings by right-clicking on the object tree in the Toolspace, Settings tab and selecting Edit Feature Settings.

Figure 1–49
Command Settings

Similar to feature settings, in the Edit Command Settings dialog box (shown in Figure 1–50), you can set the default object and label styles used when creating objects with a specific command. Each object type contains a unique set of commands. Typical values in these dialog boxes include the name format (surface 1, parcel 1, etc.), design criteria (minimum area, frontage, length of vertical curve, and minimum horizontal curve), etc. To open the dialog box, expand a collection in the Toolspace, Settings tab until the commands display. Right-click on the command to which you want to assign default settings and select Edit Command Settings.

![Edit Command Settings - AddSurfaceContours dialog box](image)

*Figure 1–50*
Hint: Style and Setting Overrides

In the Edit Label Style Defaults, Feature Settings and similar dialog boxes, a downward pointing arrow in the Child Override column indicates that a setting or style lower in the settings tree has a different value than the one displayed. Selecting the arrow (which creates a red x over the icon) and clicking OK removes the variant settings and makes all lower settings and styles match those assigned in the dialog box. This can be a quick way of standardizing multiple settings dialog boxes and styles at the same time.

For example, in the Surface Label Style defaults window (shown in Figure 1–51), some surface label styles are assigned a layer other than 0 and a visibility of false, because an arrow is present in the Child Override column. Since an arrow is not shown for the Text Style property, all surface label styles are using a text style of Standard.

![Figure 1–51](image)

The Override column indicates whether a value in this window is overriding a higher settings dialog box. Clicking the Lock icon prevents you from changing that value in a lower setting’s dialog box or style.
Styles

Styles are preconfigured groups of settings specific to an individual object type or label that make the objects print the way you want them to print. For example, in the list of surface styles shown in Figure 1–52, each surface style is configured differently to display different features, such as contours at different intervals and on the correct layers. The display of a terrain model could be changed by swapping one surface style for another. Styles enable an organization to standardize the look of their graphics by providing preconfigured groupings of display settings.

The two categories of styles you work with most often are Object Styles and Label Styles. Some objects have table styles as well. Object styles control how AutoCAD Civil 3D objects (points, surfaces, alignments, etc.) display, what combination of components the object displays, which layers they display on, and many other settings. Label Styles are similar except that they control the text and other annotations associated with the objects.

For example, an alignment object style specifies many settings including the layers on which to draw tangents and curve segments (which might be different) and which symbols to add at certain points as required (such as a triangle at the PI point). Alignment label styles include major and minor station labels, the display of station equations, design speeds, and similar annotation. By separating object and label styles, you can mix and match the right combination for a specific object.

Styles are the lowest items in the Toolspace, Settings tree and are typically dependent on other settings above them. If a style is given a unique setting, different from feature settings or label style defaults (such as a different text height), then that style is considered to have an override.
Styles in Depth

Styles are central to the AutoCAD Civil 3D software. Their flexibility enables an Office or Company to create a unique look for their drawings. By changing the assigned style, you can change the composition of a profile view as shown in Figure 1–53.

![Figure 1–53](image)

In the Toolspace, Settings tab, an object type branch identifies each style type and lists its styles below each heading. An example is shown in Figure 1–54.

![Figure 1–54](image)
Object Styles

Object Styles stylize an object's data for display. To edit a style, in the Toolspace, Settings tab, right-click on the style and select Edit. Most of the work for all object styles is done in the Display tab. For certain objects, other tabs might need to be modified.

For example, in the Surface Style dialog box, the Display tab enables you to toggle on or off triangles, borders, contours, and other items as well as define the layer, color, linetype, etc. that are assigned to them, as shown in Figure 1–55. The Contours tab sets the contour interval, smoothing, and other settings, as shown in Figure 1–56.
From the default AutoCAD Civil 3D template, the respective Parcel Style dialog box for Open Space, Road, or Single Family, (as shown in Figure 1–57), define how each displays their segments and hatching by assigning different layers for the components. The other tabs are rarely used for the Parcel styles.

Figure 1–57

An object style represents a specific task, view, type, or stage in a process. For example, a surface style for developing a surface, reviewing surface properties, or documenting surface elevations as contours for a submission. For Parcels, styles represent a type such as open space, commercial, easement, single family, etc. One style can cause an object to look different in various views. For instance, you might want to display both the point and the label in the plan view but only the point marker in a model (3D view). As shown in Figure 1–58, there are four view directions to consider when creating an object style.

Figure 1–58
Label Styles

Label styles produce annotation of critical values from existing conditions or a design solution. A label annotates a contour's elevations, a parcel's number and area, an horizontal geometry point's station on an alignment, etc.

A label style can have text, vectors, AutoCAD blocks, and reference text. The content of a label depends on the selected object's components or properties. For instance, a Line label can annotate bearing, distance, and coordinates, and use a direction arrow. A Parcel Area label can contain a parcel's area, perimeter, address, and other pertinent values. A surface label can include a spot elevation and reference for an alignment's station and offset.

- To access the values of a label style, in the Toolspace, Settings tab, select the style, right-click on its name, and select Edit.

- A style's initial values come from Edit Label Style Defaults and the style's definition.

- All labels use the same interface.

- The object properties available for each label vary by object type.

Each label style uses the same tabbed dialog box. The Information tab describes the style and who defined and last modified its contents. The values of the General tab affect all occurrences of the label in a drawing. For example, if Visibility is set to False, all labels of this style are hidden in the drawing. Other settings affect the label's text style, initial orientation, and reaction to a rotated view.
The *Layout* tab lists all of a label's components. A label component can be text, line, block, or tick. The Component name drop-down list (shown in Figure 1–59), contains all of the defined components for the style. When selecting a component name in the drop-down list, the panel displays information about the component's anchoring, justification, format, and border.

![Figure 1–59](image)

When defining a new text component, you assign it an object property by clicking ![Browse](image) (Browse) for Contents. This opens the Text Component Editor dialog box, as shown in Figure 1–60. The Properties drop-down list displays the available object properties. The number and types of properties varies by object type. For example, a parcel area label has more and different properties than a line label does. Once a property has been selected, units, precision, and other settings can be set to display the property correctly in the label. Click ![next to Properties](image) next to Properties to place the property in the label layout area to the right.
The values in the Dragged State tab define a label's behavior when it is dragged to a new location in the drawing.

The key to having the label display correctly when it is not in the dragged state, is to line up the Anchor Point of the component with the Attachment option for the text. Each has nine options from which to select. The options are shown in Figure 1–61.
Lining up the square hatched Anchor Point with the circular hatched attachment option results in the text centered above the object similar to the bearing distance label shown in Figure 1–62.

Figure 1–62

A drawing template (.DWT extension) contains all blocks, Paper Space title sheets, settings, layers, AutoCAD Civil 3D styles, and content-specific settings for a new drawing.

Creating Template Files

To use the AutoCAD Civil 3D software efficiently and effectively, you need to configure styles and settings to control the object display. All of these styles and settings affect the final delivered product and enable you to deliver a product with consistent CAD standards. Once all of the styles required for a set of drawings have been created, saving the file as a template enables you to use the same styles over and over in various projects. To create a template file, use the **Save As** command and in the Save As dialog box, change the **File of Type** to **DWT**. After giving it a name, the Template Options dialog box opens as shown in Figure 1–63. It enables you to enter a description, set the measurement units, and save new layers as reconciled or unreconciled.

Figure 1–63
Once an AutoCAD Civil 3D style has been created, it can be transferred between drawings and templates by selecting the style and dragging it to the required file. When dragging a style to a drawing, any associated style layers also transfer.

There are three methods of managing styles in a drawing: Import, Purge, and Reference. These commands are located in the Manage tab>Styles panel, as shown in Figure 1–64.

**Import**

The **Import** styles command enables you to import the styles from a source drawing into the current drawing. The Import Civil 3D Styles dialog box opens, as shown in Figure 1–65. It lists the styles that are available for import and also displays the style differences between the source and the current drawing. Each style collection lists three subcategories: styles to be added, styles to be deleted, and styles to be updated. When you use the **Import** command, the styles in the design file are overwritten. However, if the styles change in the DWG or DWT source file that you imported, the styles in the design file do not automatically update.

![Figure 1–65](image-url)
Purge

The **Purge** styles command enables you to purge all of the selected unused styles in a drawing. However, you might need to run this command more than once as there might be some styles that are used as parents to other styles. The purging information displays in the Style Purge Confirmation dialog box, as shown in Figure 1–66. The Command Line prompts you when there are no unused styles in the drawing.

![Style Purge Confirmation](image)

**Figure 1–66**
Reference

The **Reference** styles command enables you to attach one or more DWG or DWT files to your design file. Styles that are in the attached files override styles with the same name in the design drawing. If the styles in the attached DWG or DWT file change, the styles in the design file also change. Using the **Reference** styles command enables you to maintain a consistent style across multiple drawings, and can be used to implement and maintain a company-wide CAD standard. Figure 1–67 shows the Attach Referenced Template dialog box.

- When multiple style templates are attached, you can set the priority using the arrows on the right of the Attach Referenced Template dialog box.

![Attach Referenced Template dialog box](image_url)
Practice 1c AutoCAD Civil 3D Styles

Practice Objectives

- Create an object and label style to be used in the drawing.
- Import object and label styles to be used in the drawing and purge any styles not being used.

In this practice you will create AutoCAD Civil 3D styles, import styles, and purge styles for both objects and labels.

Task 1 - Create an object style.

1. Continue working in the drawing from the last practice. If you closed it, open INTRO-Introduction.dwg from the C:\Civil 3D for Surveyors Practice Files\Interface folder.

2. Select the Toolspace, Settings tab to make it active.

3. Click the + sign next to Parcel, and then click the + sign next to Parcel Styles. Five parcel styles are already in the drawing, but a new one needs to be created to designate blocks.

4. Right-click on Parcel Styles and select New. In the Information tab, type Blocks in the Name field.

5. In the Display tab, highlight both the Parcel Segment and Parcel Area Fill (press <Shift> to select both), click 0 under the Layer column.

6. In the Layer Selection dialog box, click New to create a new layer. Name the layer C-PROP-BLOCK and set its color to blue, as shown in Figure 1–68.

Figure 1–68

Estimated time for completion: 10 minutes

The tabs are listed vertically along the right side of the Toolspace.
7. Click **OK** to exit the Create Layer dialog box.

8. In the Layer Selection dialog box, select the new **C-PROP-BLOCK** layer and click **OK** to exit the Layer Selection dialog box.

9. Verify that the light bulb is on for the Parcel Segment visibility and off for the Parcel Area Fill visibility, as shown in Figure 1–69.

   ![Figure 1–69](image)

10. Click **OK** to exit the Parcel Style dialog box.

11. Save the drawing.

**Task 2 - Work with a label style.**

1. Verify that the Toolspace, **Settings** tab is still active.

2. View the label style default. In the **View** tab>**Views** panel, expand the Named Views drop-down list and select **Contour label**. It will zoom to a preset view of the contour labels, as shown in Figure 1–70.

   ![Figure 1–70](image)
Note that the labels are not rotated to the correct drafting standards. The contour label style being used is rotating the text so that it remains plan readable (so they do not display upside down). The highlighted labels are rotated more than 90 degrees from horizontal. This is caused by the Readability Bias setting being larger than 90 degrees. This setting controls the viewing angle at which the contour text should be flipped.

3. If required, you can change the setting in this specific contour label style only. To assign this new value to all of the surface label styles, in the Toolspace, Settings tab, right-click on the Surface collection and select Edit Label Style Defaults.

4. Under the Plan Readability property, set the Readability Bias to 110º, as shown in Figure 1–71, and click OK.

5. In the Toolspace, Settings tab, click + next to Surface, and then click + next to Label Styles and Contour. Right-click on Existing Major Labels and select Edit.
6. In the Layout tab, click (Browse) next to Contents to open the Text Component Editor. Delete all of the information in the content area to the right.

7. In the Properties drop-down list, select Surface Elevation, change the Precision to 1, and click to place it in the content area, as shown in Figure 1–72.

8. Click OK to exit the Text Component Editor dialog box. Click OK again to exit the Label Style Composer dialog box.

9. Repeat Steps 5 to 8 to change the Existing Minor Labels style in the same way.

10. Save the drawing.

**Task 3 - Import and purge styles.**

1. In the Manage tab>Styles panel, click (Import).

2. Select and open the Styles.dwg file from the C:\Civil 3D for Surveyors Practice Files\Interface folder.
3. Expand *Surface Styles* and verify that **Contours 1’ and 5’ (Design) with Slope Arrows** is selected, as shown in Figure 1–73.

![Image](image-url)

**Figure 1–73**

4. Click **OK** in the Warning dialog box regarding overwriting duplicate styles. Click **OK** in the Message dialog box.

5. Change the surface style to the newly imported style by changing the surface properties. Note the slope arrows shown in Figure 1–74.

![Image](image-url)

**Figure 1–74**

6. In the **Manage** tab>**Styles** panel, click **Purge**.

7. Clear any styles that you do not want to purge and click **OK**.

8. Save the drawing.
Task 4 - Attach a styles template.

1. In the Manage tab>Styles panel, click (Reference).

2. In the Attach Referenced Template dialog box, click (Attach New Template).

3. In the C:\Civil 3D for Surveyors Practice Files\Interface folder, select the Styles.dwg file and then click Open.

4. In the Attach Referenced Template dialog box, shown in Figure 1–75, click Update.

   ![Attach Referenced Template](image)
   
   **Figure 1–75**

5. Save and close the drawing.
Chapter Review Questions

1. Which Workspace should you be in if you want to create an AEC object (surfaces, alignments, profiles, etc)?
   a. 2D Drafting and Annotation
   b. 3D Modeling
   c. Civil 3D
   d. Planning and Analysis

2. What does the Toolspace, Prospector tab do?
   a. Sets the layers for AEC objects.
   b. Lists the AEC objects and provides access to their information.
   c. Sets the workspace in which you want to work.
   d. Enables you to connect to GIS data from a number of sources.

3. What does the Toolspace, Settings tab do?
   a. Sets the layers and display styles for AEC objects.
   b. Creates templates from which new drawings are based.
   c. Creates new drawings with references to data.
   d. Generates Sheets for printing purposes.

4. How do you open the Edit Drawing Settings dialog box?
   a. Type CUI in the Command Line to open the Customize User Interface dialog box.
   b. Application menu>Drawing Utilities.
   c. In the Toolspace, Prospector tab, right-click on the drawing name.
   d. In the Toolspace, Settings tab, right-click on the drawing name.

5. What is the main function of the Panorama window?
   a. Setting up styles for AEC objects.
   b. Reviewing and editing tabular AEC object data.
   c. Pan inside the drawing.
   d. Look at the AEC objects in 3D views.
6. How do you force the styles in a design file to update every time the CAD Manager makes a change to the styles in the company CAD Standards template file?

   a. In the Manage tab>Styles panel, click \(\text{Reference}\) (Reference)

   b. In the Manage tab>Styles panel, click \(\text{Purge}\) (Purge)

   c. In the Manage tab>Styles panel, click \(\text{Import}\) (Import).

   d. You have to create a new style manually because there is no way to force an update to styles in an existing drawing.
# Command Summary

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Location</th>
</tr>
</thead>
</table>
| ![Close](image) | Close | • Drawing Window  
  • Application Menu  
  • Command Prompt: close |
| ![Close Current Drawing](image) | Close Current Drawing | • Application Menu |
| ![Import Styles](image) | Import Styles | • Ribbon: Manage tab>Styles panel  
  • Command Prompt: importstylesandsettings |
| ![Manager Reference Styles](image) | Manager Reference Styles | • Ribbon: Manage tab>Styles panel  
  • Command Prompt: AttachReferenceTemplate |
| ![Open](image) | Open | • Quick Access Toolbar  
  • Application Menu  
  • Command Prompt: open, <Ctrl>+<O> |
| ![Prospector](image) | Prospector | • Ribbon: Home tab>Palettes panel  
  • Command Prompt: prospector |
| ![Settings](image) | Settings | • Ribbon: Home tab>Palettes panel  
  • Command Prompt: settings |
| ![Style Purge](image) | Style Purge | • Ribbon: Manage tab>Styles panel  
  • Command Prompt: purgестyles |
| ![Surface Properties](image) | Surface Properties | • Contextual Ribbon: Surface tab>  
  Modify panel  
  • Command Prompt: editsurfaceproperties |
| ![Survey](image) | Survey | • Ribbon: Home tab>Palettes panel  
  • Command Prompt: survey |
| ![Toolbox](image) | Toolbox | • Ribbon: Home tab>Palettes panel  
  • Command Prompt: toolbox |
| ![Toolspace](image) | Toolspace | • Ribbon: Home tab>Palettes panel  
  • Command Prompt: toolspace |